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Chapter-1: Communication Skills 
Session 1: Methods of Communication 
1. Which of the following is NOT an element of communication within the communication   
     process cycle? 
(a) Channel (b) Receiver  (c) Sender (d) Time 
 
2. You need to apply leave at work? Which method of communication will you use? 
(a) e-mail (b) Poster (c) Newsletter (d) Blog 
 
3. By which action can senders send their messages? 
(a) Gestures (b) Speaking (c) Reading (d) Writing 
 
Session 2: Verbal Communication 

1. Which of the following is an example of oral communication? 
(a) Newspapers  (b) Letters  (c) Phone call  (d) e-mail 
 
2. What are the types of words we should use for verbal communication? 
(a) Acronyms  (b) Simple  (c) Technical  (d) Jargons 
 
3. Why do we use e-mails? 
(a) To communicate with many people at the same time. 
(b) To share documents and files. 
(c) To talk to each other in real-time. 
(d) To keep a record of communication. 

Session 3: Non-verbal Communication 

1. Which of these is a positive (good) facial expression? 
(a) Frowning while concentrating  (b) Maintaining eye contact 
(c) Smiling continuously   (d) Rolling up your eyes 
 
2. What does an upright (straight) body posture convey or show? 
(a) Pride  (b) Professionalism  (c) Confidence (d) Humility 
 
3. Which of these is NOT an appropriate non-verbal communication at work? 
(a) Keeping hands in pockets while talking (b) Talking at moderate speed  
(c) Sitting straight     (d) Tilting head a bit to listen 
 
4. Which of the following statement is true about communication? 
(a) 50% of our communication is non-verbal 
(b) 20% communication is done using body movements, face, arms, etc. 
(c) 5% communication is done using voice, tone, pauses, etc. 
(d) 7% communication is done using words 

 



Session 4: Communication Cycle and Importance of Feedback 

1. Which of these are examples of positive feedback? 
(a) Excellent, your work has improved. 
(b) I noticed your dedication towards the project. 
(c) You are always doing it the wrong way. 
(d) All of the above 

2. Which of these are examples of negative feedback? 
(a) I hate to tell you this but your drawing skills are poor. 
(b) You can surely improve your drawing. 
(c) This is a good drawing but you can do better. 
(d) None of the above 
 
3. Which of the following are effective components of a good feedback? 
(a) Detailed and time consuming  (b) Direct and honest 
(c) Specific     (d) Opinion-based 
 
Session 5: Barriers to Effective Communication 

1. Which of these is NOT a common communication barrier? 
(a) Linguistic barrier  (b) Interpersonal barrier 
(c) Financial barrier  (d) Organisational barrier 
 
2. Which of these are ways to overcome communication barriers? 
(a) Respecting each other’s differences (b) Using a translator 
(c) Not communicating at all  (d) Using your own language for comfort 
 
Session 6: Writing Skills — Parts of Speech 

1. In which of the following, the underlined word is an adjective? 
(a) Radha has a red dress.   (b) I can speak French. 
(c) The Girl on the Train is a best-seller. (d) Abdul can swim fast. 
 
2. Which of these sentences is capitalised correctly? 
(a) Ravi and i are going to the movies. (b) Salim is visiting India in july. 
(c) The Tiger is a strong animal.  (d) She is arriving on Monday. 
 
3. Which of these sentences are punctuated correctly? 
(a) When is the party.   
(b) I had bread omelette and a Banana for breakfast. 
(c) I am so excited about my first foreign trip! 
(d) This is Abdul’s notebook. 
 
4. In which of these sentences can you find an adverb? 
(a) Divya drinks milk every day.  (b) Sanjay gifted me a new pen. 
(c) I opened the door lock.   (d) Sita is 5-feet tall. 
 
Session 7: Writing Skills — Sentences 

1. Identify the object, verb and subject in the sentence, ‘The car crashed into a tree.’ 
(a) Object: a tree; Verb: crashed; Subject: the car 
(b) Object: The car; Verb: crashed; Subject: a tree 
(c) Object: crashed; Verb: the tree; Subject: the car 



(d) Object: crashed; Verb: the car; Subject: the tree 
2. Identify the indirect object in the sentence, ‘The band played music for the audience.’ 
(a) The band  (b) played  (c) music  (d) audience 
 
3. Which of these is an imperative sentence? 
(a) Switch off the fan.  (b) Sheila has gone to the market. 
(c) Where are my pen colours? (d) Oh no! I missed my flight. 
 
4. Which of these sentences is in active voice? 
(a) A movie is being watched by them. 
(b) The car was repaired by Raju. 
(c) He is reading a book. 
(d) The thief was being chased by a policeman. 

Chapter-2: Self-management Skills   

Session 3: Self-motivation 

1. What makes you complete work or studies without others cheering you? 

(a) Self-confidence (b) Communication  (c) Self-motivation (d) Self-esteem 

 

2. Which of the following are types of motivation? 

(a) Internal (b) Intermediate (c) External (d) Extensive 

 

3. Ravi works hard to get the best student award at the end of year. What type of motivation is 

this? 

(a) Internal     (b) External 

(c) Both internal and external  (d) Not any specific type of motivation 

 

Chapter-3: Information and Communication Technology Skills 

Session 1 Basic Computer Operations 

1. Which of the following functions is not performed using a mouse? 

(a) Turn on  (b) Hover (c) Right click  (d) Drag and Drop 

 

2. What is the term used when you press and hold the left mouse key and move the mouse 

around? 

(a) Highlighting (b) Dragging  (c) Selecting  (d) Moving 

 

3. Here are the steps that take place when starting a computer. Rearrange the steps in the 

correct order. 

(a) Desktop appears after login (5)  (b) Login screen appears (4) 

(c) Power on Self-Test (POST) starts(1) (d) Operating system starts (2) 

(e) Welcome screen appears (3) 

Session 2: Performing Basic File Operations 

1. Which one of the following shortcut keys is used to paste a file? 

(a) Ctrl + c (b) Ctrl + p (c) Ctrl + v (d) Ctrl + x 

 

 



2. Which of the following is a valid file extension for Notepad file? 

(a) .jpg  (b) .doc (c) .text (d) .txt 

 

3. What keys do you use to copy something? 

(a) Ctrl+x (b) Ctrl+c  (c) Ctrl+z (d) Ctrl+y 

 

Session 3: Computer Care and Maintenance 

1. What happens if you leave a device plugged in even after it is charged 100%? 

(a) It can break.   (b) It can stop functioning. 

(c) It can over-heat.   (d) Data can get corrupt. 

 

2. How can an anti-virus protect your device? 

(a) It can protect it from over-heating.  (b) It can increase its performance. 

(c) It can prevent data from getting corrupt. (d) It can backup data. 

 

3. Which option is not required to keep a device cool? 

(a) Keep the device unplugged when in use.   (b) Do not cover a laptop with a blanket. 

(c) Make sure computer’s CPU fan is working.   (d) Avoid leaving the device in the sun. 

 

4. Which of the following is essential for maintaining keyboard? 

(a) Turn the keyboard upside down and shake it to remove foreign material. 

(b) Blow dust and other particles with help of a blower. 

(c) Use a very dilute combination of soap and water applied with a non-abrasive cloth to 

remove stains from the keycaps. 

(d) All of the above. 

 

Session 4: Computer Security and Privacy 

1. What should you do to ensure secure online transactions? 

(a) Lock your computer      (b) Give credit card or bank details only on safe websites 

(c) Use anti-virus            (d) Do not use pirated software 

 

2. Which of the following trap small children into inappropriate relations? 

(a) Online predators (b) Worms  (c) Trojan Horse (d) Anti-Virus 

 

3. What should a strong password consist of? 

(a) Only letters  (b) Numbers and special characters 

(c) Name of a person  (d) Letters, numbers and special characters 

 

Chapter-6 Digital Documentation (Advanced) using LibreOffice Writer  

Introduction to Styles 

1. Which of the following features in LibreOffice Writer is/are used to create the given 
document? 
(a) Page borders      (b) Envelope      (c) Picture from File    (d) Indexes and Tables 
 



2. Styles menu (from sidebar) in Writer provide options to work on 
(a) Paragraph Styles    (b) Frame Styles (c) Page Styles (d) All of the above 
 
3. What is style template in LibreOffice Writer? 
(a) Pre-determined form and mode of document file (b) One kind of model style 
(c) One type of document  (d) Cluster of documents in Writer 
 
4. Which of the following gives the status of your document like page numbers, number of 
pages? 
(a) Status bar  (b) Standard toolbar  (c) Formatting  (d) Title bar 
 
5. Which of the following can be used to access a style menu? 
(a) F11 function key    (b) Sidebar Menu   (c) Formatting toolbar   (d) All of these 
 
Fill in the blanks 
1. A __________ is a collection of different formats. (Style) 

2. Styles are especially handy in __________. (LibreOffice) 

3. Proper use of styles improves __________ in a document. (Consistency) 

4. The first five buttons at the top of the Styles window select the category of __________. (Styles) 

5. Using predefined __________ creates Bookmark in the document. (Heading Style) 

6. On opening a new file _________ Style is used for formatting the document. (Default) 

7. In page layout documents, you can arrange __________ like text boxes and graphics. (Objects) 

8. Character styles are often integrated in __________ Style. (Paragraph) 

9. __________ allows to apply style at different places in the document. (Fill Format) 

10. Predefined Style __________ be updated by Drag and Drop method. (Cannot) 

 
Working with Images 
1. The text or image which appears faintly in the background of a page is called _______. 
(a) Water mark   (b) Trade mark 
(c) Copyright    (d) Embossing 
 
2. JPG or JPEG in image format stands for _________________. 
(a) Joint Photographic Experts Group (b) Joint Picture Experts Group 
(c) Joint Photographic Experts Graph (d) Joint Photographic Experts General 
 
3. In Drawing Object Properties toolbar, Grouping options provided are ______________. 
(a) Exit Group  (b) Ungroup (c) Enter Group  (d) All of these 
 
4. Which of the following is not the correct file extension for an image file? 
(a) GIF  (b) JPEG (c) Odt  (d) PNG 
 
5. Image toolbar does not provide a tool for _________________. 
(a) filtering   (b) cropping  (c) copying   (d) flipping 
 
Fill in the blanks 
1. _________ tool cuts off non-desirable part of the image. (Crop) 



2. To change both brightness and contrast of the image ________________ tool can be used. 

(Gamma Correction) 

3. To simulate the effect of time on picture _____________ tool is used. (Ageing) 

4. _________ place image at the bottom of all objects. (Send Back) 

5. An image can be deleted by ____________ it and pressing DELETE key. (Selecting) 

6. In drawing tools, basic shapes list provide ____________ shapes. (25) 

7. Anchor act as _____________ point for a drawing. (Reference) 

8. There are ________________ options for aligning an image horizontally. (Three) 

9. The ___________ handles of image are used for rotating it. (Corner) 

10. Changing properties of an object _____________ creation, retain them throughout the session. 
(Before its) 
 
Advanced Features of Writer 
1. Which of the following is NOT true about Table of Contents, Index or Bibliography dialog 
box? 
(a) It has four tabs 
(b) On the Type tab, by default, the checkbox for Protected against Manual Changes option will 
be selected. 
(c) The Styles tab contains options to change the background colour. 
(d) None of the above 
 
2. Which of the following tabs is by default active when the Table of Contents, Entries or 
Bibliography dialog box is opened? 
(a) Entries  (b) Background (c) Styles  (d) Type 
 
3. Which of the following tabs contains options to set styles for various entries in the ToC? 
(a) Entries  (b) Background (c) Styles  (d) Type 
 
4. Which of the following can be added in the background of Table of Contents in LibreOffice 
Writer? 
(a) Color  (b) Graphic (c) Both a and b  (d) Neither a nor b 
 
5. Which of the following is NOT true about templates? 
(a) The styles and formatting features can be reused. 
(b) LibreOffice provides online templates 
(c) We cannot create our own templates. 
(d) None of the above. 
 
6. Which of the following is the shortcut key to open the Templates dialog box? 
(a) Ctrl+Alt+N  (b) Shift+Ctrl+N (c) Ctrl+Alt+T  (d) Shift+Alt+T 
 
7. Which of the following buttons, in the Templates dialog box, will be clicked to save a 
template displayed in the list of templates? 
(a) Export  (b) Import (c) Move  (d) None of the above 
 
8. Which of the following is the shortcut key to select he entire document? 
(a) Ctrl+S  (b) Ctrl+A (c) Ctrl+D  (d) Ctrl+B 



 
9. Which of the following is the correct sequence of options to open the Templates dialog box? 
(a) File > Manage Templates > Templates 
(b) File > Templates > Manage Templates 
(c) Insert > Templates >Manage Templates 
(d) Insert > Manage Templates > Templates 
 
10. Which of the following is true about Track Changes feature of Writer? 
(a) You cannot record a change made in the document. 
(b) A comment of a particular author only can be deleted 
(c) Any change made to the document is permanent. 
(d) None of the above 
 
11. Which of the following menus contains the Track Changes option? 
(a) File  (b) Edit (c) View  (d) Insert 
 
12. Which of the following is the shortcut key to start recording the changes being made in the 
document? 
(a) Ctrl+Shift+C (b) Alt+Shift+C (c) Ctrl+Alt+C  (d) Shift+C+F2 
 
Fill in the blanks 
1. To navigate to the topic from the ToC, press ___________ key while clicking the mouse button 
on that topic. (Ctrl) 
 
2. To remove the applied paragraph styling in the ToC, select the outline level in the Levels list 

box, and then click the _______ button. (default) 

3. If the checkbox for___________________ option is selected, the ToC is protected from any 
accidental change. (Protected against Manual changes) 
 
4. To update the ToC manually, right click and select ___________ option from the pop up menu. 
(Updated Index) 
 
5. The ___________ tab contains options to set the number of columns that we want to have in our 
ToC. (Columns) 
 
6. A ________________________ is a preset layout that helps us to create professional and formal 
documents easily. (Template) 
 
7. The default template in Writer is ____________________. (Blank Document Templates) 

8. To find the template that is being used in the current document, select ___________ option from 
the File menu. (Properties) 
 
9. The ____________________ button is clicked in Templates dialog box to view online templates. 
(Browse Online Template) 
 
10. The __________________ feature of Writer offers us an alternative method to keep a record of all 
the changes made in the original document. (Track Changes) 
 
11. The shortcut key to start recording the changes is _________. (Ctrl+Shift+C) 



12. After the Track Changes feature is ON, the added characters are shown as ____________ text. 
(Coloured) 
 
 
State whether the given statements are True or False 
1. The topics in Table of Contents are hyperlinked. (True) 
 
2. The Table of Contents in LibreOffice Writer can be updated automatically. (False) 
 
3. TABLE of Contents can be inserted even if the section headings are not styled. (False) 
 
4. Once a ToC is created, it cannot be edited. (False) 
 
5. We cannot add a graphic as a background of ToC. (False) 
 
6. A single template can be used for multiple documents. (True) 
 
7. A template cannot contain graphics. (False) 
 
8. All documents in Writer are based upon templates. (True) 
 
9. The online templates cannot be added to the list of templates in the templates dialog    
     box. (False) 
 
10. A template once created can be edited again and again. (True) 
 
11. The changes recorded have to be accepted by the original author. (False) 
 
12. We can delete the comments added in a document by the user. 
 
 

Chapter-7 Electronic Spreadsheet (Advanced) using LibreOffice Calc 
 

Analyse Data using Scenarios and Goal Seek 
1. Which of the following feature is not used for data analysis in spreadsheet? 
(a) Consolidating data (b) Goal Seek  (c) Subtotal  (d) Page layout 
 
2. Which of the following office tool is known for data analysis? 
(a) Writer (b) Calc (c) Impress (d) Draw 
 
3. Which of the following operations cannot be performed using LibreOffice Calc? 
(a) Store and manipulate data (b) Create graphical representation of data 
(c) Analysis of data   (d) Mail merge 
 
4. What is the extension of spreadsheet file in Calc? 
(a) .odb (b) .odt (c) .odg (d) .ods 
 
5. The default function while using Consolidate is ____________. 
(a) Average  (b) Sum (c) Max (d) Count 
 
6. Group by is used in _____________ tool to apply summary functions on columns. 
(a) Consolidate function (b) Group and Outline  



(c) What-if scenario  (d) Subtotal tool 
 
7. Which tool is used to predict the output while changing the input? 
(a) Consolidate function (b) What-if scenario 
(c) Goal seek   (d) Fine and Replace 
 
8. Which of the following is an example for absolute cell referencing? 
(a) C5  (b) $C$5 (c) $C  (d) #C 
 
9. _____________ analysis tool works in reverse order, finding input based on the output. 
(a) Consolidate function (b) Goal seek     (c) What-if analysis (d) Scenario 
 
State whether the following statements are True or False 
1. Consolidate function is used to combine information from two or more sheets into 

one.(True) 

2. Consolidate function cannot be used to view and compare data. (False) 

3. Link to source data is checked updates the target sheet if any changes made in the source 

data. (True) 

4. Using subtotal in Calc needs to use filter data for sorting. (False) 

5. Subtotal tool can use only one type of summary function for all columns. (False) 

6. Only one scenario can be created for one sheet. (False) 

7. What-if analysis tool uses one array of cells. (False) 

8. Goal seek analysis tool is used while calculating the output depending on the input. (False) 

9. The output of What-if tool is displayed in the same cell. (False) 

 
Fill in the blanks 
1. Consolidate function is used to combine information from multiple sheets to 
_______________________ the information. (Summarize) 
 
2. Data can be viewed and compared in a single sheet for identifying trends and relationships 
using ______________ function. (Consolidate) 
 
3. ________________ under Data menu can be used to combine information from multiple sheets 
into one sheet to compare data. (Subtotal) 
 
4. The _________________ tool in Calc creates the group automatically and applies functions on the 
grouped data. (Subtotal) 
 
5. _______________ scenario is used to explore and compare various alternatives depending on 
changing conditions. (What-if) 
 
6. ______________ is a planning tool for what-if questions. (What-if Tool) 

7. What-if analysis tool uses ____________ array of cells, one array contains input values and the 
second uses the _____________. (Two,    Formula and Display Output) 
 
8. _____________ helps in finding out the input for the specific output. (Goal Seek) 

 
Using Macros in Spreadsheet 
1. Macro Recordings can be enabled from the ________ option in the menu bar. 



(a) Sheet  (b) Data (c) Tools (d) Window. 
 
2. Which of the following is an invalid Macro Name? 
(a) 1formatword (b) format word (c) format*word (d) Format_word. 
 
3. Which of the following Libraries contains modules with prerecorded macros and should not 
be changed? 
(a) My Macros (b) LibreOfficeMacros (c) Untitled1  (d) Test. 
 
4. Identify which of the following is a programming Language? 
(a) Calc (b) BASIC (c) Writer (d) Macro. 
 
5. The Module can be executed from the IDE by pressing  _________________. 
(a) F3  (b) F4  (c) F5  (d) F6 
 
6. Which of the following is the default name of the Macro _______________. 
(a) Default  (b) Main (c) Macro1  (d) Main_Macro 
 
 
Fill in the blanks 
1. ________ library is automatically loaded when the document is opened.(Standard) 

2. IDE stands for _______________________________. (Integrated Development Environment) 

3. Macro as a function is capable of accepting ___________ and returning a ____________. 
(arguments/values, result/value) 
 
4. Macro ________________ allows us to add, delete a module. (Organizer) 

5. The code of macro begins with __________ followed by the name of the macro and ends with 
__________. (Sub, End Sub) 
 
6. By default a macro is saved in the _____________ . (Standard Library) 

 
State whether the following statements are True or False 
1. Macro is a group of instructions executing a single instruction. (False) 

2. Once created, Macro can be used any number of times.(True) 

3. By default, the Macro recording feature is turned on. (False) 

4. It is not possible to stop recording of a Macro. (False) 

5. Every Macro should be given a unique name. (True) 

6. A macro once created can be edited later. (True) 

 
Linking Spreadsheet Data 
 
1. Insert Sheet dialog can be invoked from _______________. 
(a) sheet (b) insert (c) tools (d) Windows 
 
2. ______________ refers to cell G5 of sheet named My Sheet. 
(a) $My Sheet.’G5’  (b) $My Sheet_’G5’ 
(c) $ ‘MySheet’.G5  (d) $ ‘MySheet’_G5 
 
3. The path of a file has ____________ forward slashes. 



(a) four (b) three (c) two (d) one 
 
4. Which of the following feature is used to jump to a different spreadsheet from the current 
spreadsheet in LibreOffice Calc? 
(a) Macro (b) Hyperlink  (c) connect  (d) Copy 
 
Fill in the blanks 
1. A relative hyperlink stores the location with respect to the ___________ location. (current) 
 
2. While inserting tables from a webpage _____________ selects the entire HTML document. 
(HTML_all) 
 
3. The extension of LibreOffice base is ______________. (.odb) 

4. __________ are used to enclose sheet names as there might be a space within sheet names. 
(Single quotes (‘ ’)) 
 
5. The From file option of ___________ Dialog box allows to insert sheet from another file.  (Insert 
Sheet) 
 
State whether the following statements are True or False 
1. A sheet can only be added before the current sheet.(False) 

2. If ‘sales’ sheet has a reference to ‘cost’ sheet then any changes made to ‘cost’ sheet will be 

reflected in the sales sheet as well.(True) 

3. It is not possible to link a sheet as a reference in another sheet. (False) 

4. We can insert data from a table created on a web page into a spreadsheet. (True) 

5. A hyperlink once created on a sheet cannot be deleted. (False) 

 
Share and Review a Spreadsheet 
1. Sharing allows to edit the spreadsheet by 
(a) single user  (b) different users simultaneously 
(c) one by one users  (d) one after other users 
 
2. Sharing spreadsheet feature allows to save the changes in 
(a) multiple sheets  (b) user’s sheet 
(c) in a same sheet  (d) in different sheet 
 
3. The Recording Changes feature of LibreOffice Calc provides different ways to record the 
changes made by ____________ in the spreadsheet. 
(a) one user  (b) other user  (c) the user  (d) one or other users 
 
4. In Calc, the comments are added 
(a) automatically (b) by author  (c) by reviewer (d) all of above 
 
5. The changes by team members in the spreadsheet can be accepted or rejected by 
(a) the team members (b) any of the user  (c) owner (d) other users 
 
State whether the following statements are True or False 
1. Spreadsheet cannot be shared to work with more than one user. (False) 

2. Some of the features becomes unavailable when the spreadsheet is in shared mode.(True) 



3. You can record changes in the spreadsheet when the spreadsheet is opened in shared mode. 

(False) 

4. File menu is used to Record changes for the spreadsheet. (False) 

5. You can add a note or suggestion in the spreadsheet using Insert Comment. (False) 

6. Formatting comment can be used to change the font colour of the comment. (True) 

 
Fill in the blanks 
1. The title bar of the document shows __________________ along with the filename for the shared 
mode of the spreadsheet. (Shared) 
 
2. The shared mode spreadsheet allows __________ users to access and edit the spreadsheet at 
the same time. (many) 
 
3. Recording changes automatically ____________ the shared mode of a spreadsheet. (Turn off) 
 
4. Click on Edit menu, Track Changes and then select ____________ to record the changes in the 
spreadsheet. (Record) 
 
5. The border color of the changed cell will be ______________. (Red) 

6. ____________ is used to add notes or suggestions to a cell in a spreadsheet. (Comment) 

7. The comment box can be formatted just like formatting the __________. (cell contents) 


